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Ειζαγωγή 

΢θνπόο ηεο παξνύζεο εξγαζίαο είλαη ε ελαζρόιεζε ηνπ ζπνπδαζηή κε ηα 

ζύγρξνλα ινγηζκηθά εξγαιεία πξνζνκνίσζεο κεραληζκώλ ζηνλ ειεθηξνληθό 

ππνινγηζηή θαη ε δηεξεύλεζε ησλ δπλαηνηήησλ ηνπ Pro/Engineer ζην 

ζρεδηαζκό, ηε ζπλαξκνιόγεζε θαη ηελ πξνζνκνίσζε θίλεζεο κεραληζκώλ. 

Σέηνηνη κεραληζκνί κπνξεί λα είλαη κεραληζκνί κεηάδνζεο θίλεζεο (γξαλάδηα, 

ηκάληεο), ειαηήξηα θ.α. 

 

Γνκή εξγαζίαο 

Η εξγαζία απνηειείηαη από ηέζζεξα θεθάιαηα. ΢ην πξώην θεθάιαην γίλεηαη 

κηα εηζαγσγή ζηνπο κεραληζκνύο θαη παξνπζηάδνληαη θάπνηεο βαζηθέο έλλνηεο 

θαη νξηζκνί ζρεηηθά κε ην ζρεδηαζκό θαη ηε ζπλαξκνιόγεζή ηνπο.  

΢ην δεύηεξν θεθάιαην γίλεηαη παξνπζίαζε ησλ βαζηθόηεξσλ ελλνηώλ ηνπ 

pro/Engineer θαη ηνπ mechanism κε εηδηθή αλαθνξά ζηηο πην βαζηθέο εληνιέο 

ηνπο.  

΢ην ηξίην θεθάιαην παξνπζηάδνληαη ιεπηνκεξή tutorials ηεζζάξσλ βαζηθώλ 

κεραληζκώλ από ην ζρεδηαζκό ησλ επηκέξνπο εμαξηεκάησλ, ζηε 

ζπλαξκνιόγεζή ηνπο θαη ζηνλ νξηζκό ησλ ζηνηρείσλ ησλ κεραληζκώλ. 

 ΢ην ηέηαξην θαη ηειεπηαίν θεθάιαην παξνπζηάδνληαη ηα γεληθά ζπκπεξάζκαηα 

ηεο εξγαζίαο. 
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1. Μητανιζμοί 

Ο κεραληζκόο είλαη κηα κεραλνινγηθή θαηαζθεπή πνπ πξνθύπηεη από ην 

ζπλδπαζκό άθακπησλ ζσκάησλ, θαηαζθεπαζκέλσλ θαη ζπλαξκνινγεκέλσλ 

ώζηε λα πξαγκαηνπνηνύλ πξνθαζνξηζκέλεο θηλήζεηο, ε νπνία κεηαθέξεη 

θίλεζε ή δύλακε. Μπνξεί λα είλαη κέξνο ελόο κεγαιύηεξνπ ζπζηήκαηνο 

(κεραλήο).  

 

Σκήκαηα κεραληζκώλ: 

΢ηνηρεία ζύλδεζεο: ήινη, θνριίεο, ζθήλεο, πείξνη θιπ 

΢ηνηρεία έδξαζεο ή κεηάδνζεο θίλεζεο: έδξαλα νιίζζεζεο θαη θύιηζεο, 

άμνλεο, άηξαθηνη, ζπκπιέθηεο, νδνλησηνί ηξνρνί θαη κεησηήξεο ζηξνθώλ, 

ηκάληεο θαη αιπζίδεο θίλεζεο 

Η Κηλεκαηηθή είλαη θιάδνο ηεο κεραληθήο πνπ πεξηγξάθεη ηελ θίλεζε ησλ 

ζσκάησλ αδηαθνξώληαο γηα ηε κάδα ηνπο ή ηηο αηηίεο, δπλάκεηο, πνπ 

πξνθαινύλ ηελ θίλεζή ηνπο. ΢ηελ θηλεκαηηθή, ν κεραληζκόο είλαη έλαο ηξόπνο 

κεηάδνζεο, ειέγρνπ ή πεξηνξηζκνύ ζρεηηθήο θίλεζεο.  

Όηαλ αλάκεζα ζε δύν άθακπηα ζώκαηα εκθαλίδεηαη ζρεηηθή θίλεζε κέζσ 

πεξηνξηζκνύ ησλ βαζκώλ ειεπζεξίαο ηνπο, ε ζύλδεζε απηή νλνκάδεηαη 

θηλεκαηηθό δεύγνο (άξζξσζε). Αλάινγα κε ηνλ ηξόπν επαθήο ησλ δύν 

ζσκάησλ νη ηύπνη αξζξώζεσλ θαηαηάζζνληαη σο εμήο: 

Υακεινύ επηπέδνπ δεύγε: Ο πεξηνξηζκόο θίλεζεο έρεη λα θάλεη κε επαθή 

επηθαλεηώλ (πρ ηύπνο ζύλδεζεο “Pin”, ζπλδέζεηο κε θύιηζε, θπιπλδξηθέο 

ζπλδέζεηο θιπ) 

Τςεινύ επηπέδνπ δεύγε: Ο πεξηνξηζκόο θίλεζεο έρεη λα θάλεη κε επαθή 

ζεκείσλ ή θακπύισλ (πρ έθθεληξα, νδνλησηνί ηξνρνί θιπ).  

Αθνινπζνύλ θάπνηα παξαδείγκαηα κεραληζκώλ. 

Μεραληζκόο ησλ  Αληηθπζήξσλ 
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Ο Μεραληζκόο ησλ Αληηθπζήξσλ (γλσζηόο θαη σο αζηξνιάβνο ησλ 

Αληηθπζήξσλ) πήξε απηή ηελ νλνκαζία από ην λαπάγην θνληά ζηε λήζν 

Αληηθύζεξα, κέζα ζην νπνίν βξέζεθε ην 1901. Άιιεο νλνκαζίεο πνπ 

ρξεζηκνπνηνύληαη γηα ηνλ ραξαθηεξηζκό απηνύ ηνπ επξήκαηνο είλαη 

«ππνινγηζηήο» θαη «πιαλεηάξην». Τπνλνείηαη δειαδή όηη πξόθεηηαη γηα έλα 

κεραληθό «ππνινγηζηή», ν νπνίνο βάζεη ησλ γεσκεηξηθώλ ζρέζεσλ ησλ 

γξαλαδηώλ ηνπ αλαπαξάγεη δηάθνξα αζηξνλνκηθά θαηλόκελα.  δειαδή 

πξόθεηηαη γηα έλα αλαινγηθό ππνινγηζηή, αθνύ ηα απνηειέζκαηα πνπ 

αλαθέξνληαη ζε ρξνληθέο ζηηγκέο θαη πεξηόδνπο, πξνθύπηνπλ θαη’ αλαινγία 

πξνο κεραληθά κεγέζε. 

 

 

΢ηα δηαβξσκέλα ππνιείκκαηα ηνπ κεραληζκνύ πνπ παξέκεηλαλ 20 θαη πιένλ 

αηώλεο ζηε ζάιαζζα, θαίλνληαη αθόκα θιίκαθεο κε βαζκνλνκήζεηο θαηά ην 

δσδηαθό θύθιν ηεο Αζηξνινγίαο θαη ηα ειιεληθά νλόκαηα ησλ κελώλ πνπ 
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ρξεζηκνπνηνύληαλ ηόηε. ΢ηελ πίζσ πιεπξά ηνπ κεραληζκνύ ππάξρνπλ 

ηέζζεξηο πεξηζηξεθόκελνη νκόθεληξνη ηξνρνί (δαθηπιίδηα), κε ηνπο νπνίνπο 

ππνινγίδνληαλ ζέζεηο θαη θαηλόκελα ησλ γλσζηώλ πιαλεηώλ θαη άιισλ 

νπξάλησλ ζσκάησλ. Ο θύξηνο κεραληζκόο πεξηιακβάλεη γξαλάδηα κε δόληηα 

πνπ έρνπλ θνπεί κε θιίζε 60ν, θαζώο επίζεο έλα δηαθνξηθό ζύζηεκα γηα ηελ 

εθηέιεζε αθαηξέζεσλ. 

Έξεπλεο θαη κειέηεο έδεημαλ όκσο όηη ν κεραληζκόο απηόο ρξνλνινγείηαη 

αλάκεζα ζην 150 θαη ην 100 π.Υ. ΢’ απηέο ηηο έξεπλεο επηβεβαηώζεθε αθόκα 

όηη ν κεραληζκόο δελ ήηαλ απιά έλα νκνίσκα αιιά βξηζθόηαλ ζε ιεηηνπξγία, 

όηαλ λαπάγεζε ην πινίν. Απηό ζπκπεξαίλεηαη από ην γεγνλόο όηη είραλ γίλεη 

δύν επηδηνξζώζεηο ζην κεραληζκό θαη ζπγθεθξηκέλα, είραλ αληηθαηαζηαζεί έλα 

δόληη γξαλαδηνύ θαη ε αθηίλα ελόο ηξνρνύ πνπ είραλ ζπάζεη. 

 

Σξνρόο ηεο Γελεύεο (Geneva Drive) 

 

Ο κεραληζκόο απηόο απνηειείηαη από έλα δεύγνο ηξνρώλ θαη κεηαηξέπεη ηε 

ζπλερόκελε πεξηζηξνθηθή θίλεζε ζε δηαθνπηόκελε πεξηζηξνθηθή θίλεζε. Ο 

θηλεηήξηνο ηξνρόο έρεη έλα θπιηλδξηθό ηκήκα (pin) ην νπνίν εθηειώληαο 

πεξηζηξνθηθή θίλεζε γύξσ από ηνλ άμνλα ηνπ ηξνρνύ, ζπκπιέθεηαη κε ηα 
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απιάθηα πνπ ππάξρνπλ ζηνλ θηλνύκελν ηξνρό, κε απνηέιεζκα ν θηλνύκελνο 

ηξνρόο λα πεξηζηξέθεηαη θαηά έλα βήκα γηα θάζε πεξηζηξνθή ηνπ θηλεηήξηνπ 

ηξνρνύ.  

 

Απηόο ν κεραληζκόο ρξεζηκνπνηείηαη ζηηο κεραλέο πξνβνιήο ηαηληώλ. Σν θηικ 

δελ πεξλάεη κε ζηαζεξή ηαρύηεηα κπξνζηά από ην θαθό, αιιά πξνρσξάεη 

θαξέ θαξέ, κε θάζε θαξέ λα κέλεη αθίλεην κπξνζηά ζην θαθό γηα 1/24 ηνπ 

δεπηεξνιέπηνπ όπνπ γίλεηαη δηπιή έθζεζε, κε απνηέιεζκα ηε ζπρλόηεηα 

48Hz. Πην ζύγρξνλεο κεραλέο ρξεζηκνπνηνύλ ειεθηξνληθά ζπζηήκαηα ή 

βεκαηηθνύο θηλεηήξεο. 

Άιιε εθαξκνγή ηνπ κεραληζκνύ απηνύ είλαη ζε κεραληθά ξνιόγηα, όπνπ 

ρξεζηκεύεη ζηνλ πεξηνξηζκό ηεο ηάζεο πνπ δέρεηαη ην ειαηήξην. Γελ επηηξέπεη 

ζην κεραληζκό πνπ θνπξδίδεη ην ξνιόη λα εθαξκόδεη πεξηζζόηεξε ηνπ 

επηηξεπηνύ ηάζε ζην ειαηήξην. ΢’ απηή ηελ πεξίπησζε ν κεραληζκόο 

νλνκάδεηαη Geneva Stop.  

 

Μεραληθό mouse 

Σν πνληίθη (mouse) είλαη ζπζθεπή εηζόδνπ πνπ ρξεζηκνπνηείηαη ζηνπο 

ειεθηξνληθνύο ππνινγηζηέο (Η/Τ). Πξηλ ηελ εκθάληζε ησλ νπηηθώλ, laser,  

γπξνζθνπηθώλ θιπ πνληηθηώλ, ηα κεραληθά πνληίθηα θάιππηαλ ηηο αλάγθεο 

ησλ ρξεζηώλ Η/Τ.   
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Ο ηξόπνο ιεηηνπξγίαο ηνπ κεραληθνύ κέξνπο γηα ηελ αληηζηνίρεζε ηεο θίλεζεο 

ηνπ πνληηθηνύ κε παξόκνηα θίλεζε ελόο ίρλνπο (θέξζνξα) ζηελ νζόλε ηνπ Η/Τ 

είλαη ν εμήο: 

Καζώο ην πνληίθη θπιάεη πάλσ ζε επηθάλεηα, ε κπίιηα αθνύ εθάπηεηαη ζηελ 

επηθάλεηα απηή, πεξηζηξέθεηαη ειεύζεξα πξνο θάζε θαηεύζπλζε ρσξίο όκσο 

λα μεθεύγεη από ηε ζέζε ηεο. Ρνδέιεο ζηνπο άμνλεο x, y πηάλνπλ ηελ θίλεζε 

ηεο κπίιηαο θαη ηε κεηαθέξνπλ ζηνπο δίζθνπο δύν νπηηθώλ encoders, νη 

νπνίνη ζηέιλνπλ ην ζήκα ζε onboard chip πνπ κεηαθξάδεη ηα δεδνκέλα ζε 

κνξθή πνπ λα κπνξεί λα δηαβάζεη ν ππνινγηζηήο.  

Γηα λα κέλεη ε κπίιηα ζηε ζέζε ηεο θαη λα κπνξεί λα πεξηζηξέθεηαη ειεύζεξα 

θαη λα θπιάεη ρσξίο νιίζζεζε πάλσ ζηελ επηθάλεηα, ζα πξέπεη λα 

πεξηνξίδνληαη νη ηξεηο βαζκνί ειεπζεξίαο πνπ νξίδνπλ ηε ζέζε ηεο θαη λα 

παξακέλνπλ αλνηρηνί νη άιινη ηξεηο πνπ νξίδνπλ ηνλ πξνζαλαηνιηζκό ηεο. 

Σν ζύζηεκα ηνπ encoder ζα πξέπεη λα κπνξεί λα πεξηζηξέθεηαη γύξσ από 

ηνλ άμνλά ηνπ, ρσξίο λα θηλείηαη θαηά κήθνο απηνύ ηνπ άμνλα, έηζη ώζηε ε 
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ξνδέια λα βξίζθεηαη πάληα ζε επαθή κε ηε κπίιηα θαη ν δηάηξεηνο δίζθνο λα 

βξίζθεηαη αλάκεζα από ην led θαη ηε θσηνδίνδν. Απηό ην ζύζηεκα έρεη κόλν 

έλαλ βαζκό ειεπζεξίαο, απηόλ ηεο πεξηζηξνθήο γύξσ από ηνλ άμνλά ηνπ. 

΢θνπόο ηεο παξνύζαο εξγαζίαο είλαη ε κειέηε θαη ε παξνπζίαζε 

ππνινγηζηηθώλ εξγαιείσλ, γηα ηελ νπηηθνπνίεζε θαη ηελ πξνζνκνίσζε ηεο 

θηλεκαηηθήο κεραληζκώλ ζε ειεθηξνληθό ππνινγηζηή. 
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2. Pro/Engineer - Mechanism 

2.1. Ειζαγωγή ζηο Pro/Engineer 

Σν Pro/Engineer είλαη έλα ινγηζκηθό 3D CAD/CAM/CAE πνπ ρξεζηκνπνηεί 

παξακεηξηθό (Parametric) ζύζηεκα ζηεξεάο θαη επηθαλεηαθήο 

κνληεινπνίεζεο (Solid - Surface Μodeling) βαζηζκέλν ζε ραξαθηεξηζηηθά 

(Feature based). 

Parametric: Σν γεσκεηξηθό ζηεξεό εμαξηάηαη άκεζα από ηηο ηηκέο πνπ έρνπλ 

δνζεί ζηα features ηνπ. Η κεηαβνιή κηαο ηηκήο ελόο feature έρεη σο 

απνηέιεζκα ηε κεηαβνιή ηηκώλ άιισλ features ηα νπνία εμαξηώληαη από 

απηό θαη θαηά ζπλέπεηα ηε κεηαβνιή ηνπ ζρήκαηνο ηνπ ζηεξενύ 

Feature Based: Σν γεσκεηξηθό κνληέιν δεκηνπξγείηαη από features πςεινύ 

επηπέδνπ (αθαίξεζε/πξνζζήθε πιηθνύ, νπέο θιπ) αληί γηα ρακεινύ επηπέδνπ 

(γξακκέο, ηόμα, θύθινη θιπ). Αλάκεζα ζηα features ελόο κνληέινπ κπνξνύλ 

λα δεκηνπξγεζνύλ ζρέζεηο, ώζηε κεηαβάιινληαο έλα feature λα 

κεηαβάιινληαη θαη όζα εμαξηώληαη απν απηό. 

Καηά ηε δηάξθεηα ηεο επηινγήο parts πξνο ζπλαξκνιόγεζε ή δεκηνπξγία ζην 

assembly ππάξρνπλ νη εμήο επηινγέο: 

 

Assemble: Δηζαγσγή ήδε ζρεδηαζκέλνπ part πξνο ζπλαξκνιόγεζε 

Manikin: Δηζαγσγή αλζξσπόκνξθνπ κνληέινπ 

Create: Γεκηνπξγία part κέζα από ην assembly 

Hole: Γεκηνπξγία ηππνπνηεκέλεο νπήο 

Draft 

Round 

Edge Chamfer 
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Δπηιέγνληαο assemble θαη εηζάγνληαο θάπνην part εκθαλίδεηαη ην component 

placement dashboard (εηθόλα 01) ην νπνίν πεξηέρεη ηηο επηινγέο θαη ηνπο 

ηξόπνπο ζπλαξκνιόγεζεο. 

 

Δηθόλα 01. Component Placement Dashboard 

Σα πξνθαζνξηζκέλα ζεη πεξηνξηζκώλ νξίδνπλ ηελ θίλεζε ελόο εμαξηήκαηνο 

κέζα ζην assembly. Έλα ηέηνην ζεη πεξηέρεη ηνπο πεξηνξηζκνύο πνπ νξίδνπλ 

ηνλ ηύπν ζύλδεζεο, κε ή ρσξίο άμνλα θίλεζεο. Οη ζπλδέζεηο θαζνξίδνπλ 

ζπγθεθξηκέλνπο ηύπνπο θηλήζεσλ. Όια ηα πξνθαζνξηζκέλα ζεη πεξηνξηζκώλ 

κπνξνύλ λα ππνζηνύλ επεμεξγαζία ζην Mechanism Design. 

Σα εμαξηήκαηα πνπ ζπλαξκνινγνύληαη κε ηα ζεη πεξηνξηζκώλ κέλνπλ όρη 

πιήξσο πεξηνξηζκέλα ώζηε λα δηαηεξνύλ έλαλ ή πεξηζζόηεξνπο βαζκνύο 

ειεπζεξίαο. 

Rigid: ΢πλδέεη δπν εμαξηήκαηα ώζηε λα κελ ππάξρεη ζρεηηθή θίλεζε κεηαμύ 

ηνπο. Σα εμαξηήκαηα πνπ ζπλδένληαη κε απην ηνλ ηξόπν ζπκπεξηθέξνληαη 

ζαλ έλα αθακπην ζώκα. Απηόο ν ηύπνο πεξηνξηζκνύ είλαη παξόκνηνο κε ην 

User Defined ζεη. Πεξηέρεη: Mate, Align, Insert, Coordinate System, Tangent, 

Point On Line, Point On Surface, Edge On Surface θαη Fix. 

Pin: ΢πλδέεη έλα εμάξηεκα ζε άμνλα, ώζηε ην εμάξηεκα λα πεξηζηξέθεηαη 

γύξσ από ηνλ άμνλα ή λα θηλείηαη πάλσ ζε απηόλ, κε έλαλ βαζκό ειεζεξίαο. 

Απηό ην ζεη έρεη δύν πεξηνξηζκνύο: Axis alignment θαη planar mate ή align. 

Slider: ΢πλδέεη έλα εμάξηεκα ζε άμνλα, ώζηε ην εμάξηεκα λα θηλείηαη πάλσ ζε 

απηόλ, κε έλαλ βαζκό ειεζεξίαο. Απηό ην ζεη έρεη δύν πεξηνξηζκνύο 

θηλήζεσλ: axis alignment θαη planar mate/align γηα πεξηνξηζκό ηεο 

πεξηζηξνθήο πάλσ ζηνλ άμνλα (rotation). 
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Cylinder: ΢πλδέεη έλα εμάξηεκα ζε άμνλα ώζηε λα θηλείηαη θαηά κήθνο θαη λα 

πεξηζηξέθεηαη γύξσ από απηόλ κε δύν βαζκνύο ειεπζεξίαο. Απηό ην ζεη έρεη 

κόλν ηνλ πεξηνξηζκό axis alignment. 

Planar: ΢πλδέεη δπν εμαξηήκαηα ώζηε λα θηλνύληαη ην έλα ζε ζρέζε κε ην 

άιιν πάλσ ζε επίπεδν κε δύν βαζκνύο ειεπζεξίαο σο πξνο ην επίπεδν θαη 

λα πεξηζηξέθνληαη γύξν από άμνλα θάζεην ζην επίπεδν απηό κε έλαλ βαζκό 

ειεπζεξίαο. Απηό ην ζεη έρεη κόλν ηνλ πεξηνξηζκό planar mate/align (κπνξεί 

λα γίλεη flip).  

Ball: ΢πλδέεη έλα εμάξηεκα ώζηε λα κπνξεί λα πεξηζηξέθεηαη πξνο 

νπνηαδήπνηε θαηεύζπλζε κε ηξεηο βαζκνύο ειεπζεξίαο (πεξηζηξνθή 360˚). 

Απηό ην ζεη έρεη έλα point to point alignment πεξηνξηζκό. 

Weld: ΢πλδέεη έλα εμάξηεκα πάλσ ζε άιιν ώζηε λα κελ ππάξρεη ζρεηηθή 

θίλεζε κεηαμύ ηνπο. Σν εμάξηεκα ηνπνζεηείηαη ζην assembly ηαπηίδνληαο ην 

ζύζηεκα ζπληεηαγκέλσλ ηνπ εμαξηήκαηνο κε έλα ηνπ assembly. Η ζέζε ηνπ 

εμαξηήκαηνο κπνξεί λα ξπζκηζηεί πεξεηαίξσ ρξεζηκνπνηώληαο ηνπο κε 

πεξηνξηζκέλνπο βαζκνύο ειεπζεξίαο ηνπ. Απηό ην ζεη έρεη έλαλ πεξηνξηζκό 

coordinate system alignment. 

Bearing: Απηό ην ζεη είλαη ζπλδπαζκόο ησλ ζεη Ball θαη Slider κε ηέζζεξηο 

βαζκνύο ειεπζεξίαο. Τπάξρνπλ ηξεηο βαζκνί ειεπζεξίαο γηα ηελ πεξηζηξνθή 

360˚ θαη έλαο γηα θίλεζε θαηά κήθνο ζε άμνλα. Έρεη έλαλ πεξηνξηζκό point on 

edge alignment. 

General: Έρεη έλαλ ή δύν ξπζκηδόκελνπο πεξηνξηζκνύο όκνηνπο κε απηνύο 

ηνπ user defined set. 

6DOF: Γελ επεξξεάδεη ηελ θίλεζε ηνπ εμαξηήκαηνο, γηαηί δελ εθαξκόδεηαη 

θαλέλαο πεξηνξηζκόο. Σν ζύζηεκα ζπληεηαγκέλσλ ηνπ εμαξηήκαηνο 

επζπγξακκίδεηαη κε έλα ηνπ assembly. Οη άμνλεο x, y, θαη z ηνπ assembly είλαη 

άμηλεο θίλεζεο θαη επηηξέπνπλ πεξηζηξνθηθή (rotation) θαη νκνηόκνξθε κε 

πεξηζηξνθηθή θίλεζε (translation). 

Slot: ΢πλδέεη ζεκείν κε κε επζύγξακκε ηξνρηά. Απηή ε ζύλδεζε αθήλεη 

ηέζζεξηο βαζκνύο ειεπζεξίαο όπνπ ην ζεκείν αθνινπζεί ηελ ηξνρηά ζε ηξεηο 
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θαηεπζύλζεηο. Απηό ην ζεη έρεη πεξηνξηζκό single point alignment ζε 

πνιιαπιέο αθκέο ή θακπύιεο. 

 

2.2. Ειζαγωγή ζηο Mechanism 

Σν application mechanism ηνπ Pro/Engineer είλαη έλα εξγαιείν θηλεκαηηθήο θαη 

δπλακηθήο αλάιπζεο. Μπνξεί λα ρξεζηκνπνηεζεί γηα:  

o Σε δεκηνπξγία απιώλ ή θαη ζύλζεησλ κεραληζκώλ 

o Σνλ νξηζκό ησλ ζπλδέζεσλ κεηαμύ δηαθνξεηηθώλ ζηνηρείσλ ελόο 

assembly 

o Σνλ νξηζκό θηλεηήξσλ θαη ησλ παξακέηξσλ ηνπο 

o Σελ πξνζνκνίσζε θίλεζεο ησλ ζηνηρείσλ ηνπ κεραληζκνύ ζε 

θαζνξηζκέλεο ηξνρηέο 

o Σελ αλάιπζε ηαρύηεηαο θαη επηηάρπλζεο γηα ηα επηκέξνπο parts ελόο 

assembly 

o Σελ εθηέιεζε θύθισλ θίλεζεο ησλ κεραληζκώλ 

o Σε δεκηνπξγία ηξνρηώλ γηα θίλεζε κεξώλ ηνπ κεραληζκνύ 

o Σελ απνζήθεπζε ζε video ηεο πξνζνκνίσζεο θίλεζεο ηνπ 

κεραληζκνύ. 

o Σελ αμηνιόγεζε ησλ απνηειεζκάησλ ηεο αλάιπζεο 

 

Μεηά ηελ πιήξε ζπλαξκνιόγεζε ελόο κεραληζκνύ, ην assembly πεξλάεη ζην 

application mechanism ηνπ pro/Engineer γηα ηνλ νξηζκό ησλ ζηνηρείσλ ηνπ 

κεραληζκνύ. Δδώ ππάξρνπλ νη εμήο επηινγέο: 

 Mechanism Display: Δδώ επηιέγνληαη ηα ζηνηρεία ησλ κεραληζκώλ πνπ 

ζα είλαη νξαηά. 

 

 Cams: Αλνίγεη ην παξάζπξν δηαιόγνπ Cam-Follower Connection 

Definition γηα ηε δεκηνπξγία ή ηελ επεμεξγαζία ζύλδεζεο ηύπνπ cam-follower.  
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΢ηελ πξώηε θαξηέια (Cam1) ζπκπιεξώλνληαη ηα ζηνηρεία ηνπ πξώηνπ cam. 

Δπηιέγεηαη ε επηθάλεηα πνπ ζα αιιειεπηδξά κε ην δεύηεξν cam. Αλ είλαη 

ελεξγή ε επηινγή Autoselect ζα επηιεγνύλ απηόκαηα θαη νη παξαθείκελεο 

επηθάλεηεο. Αιιαγή ηεο θαηεύζπλζεο επαθήο ηεο επηθάλεηαο γίλεηαη παηώληαο 

flip.  

Αλ επηιεγεί επηθάλεηα ξπζκίδεηαη ν πξνζαλαηνιηζκόο ηνπ cam πάλσ ζηελ 

επηθάλεηα κε ηηο επηινγέο Depth Display Settings. 

Η ίδηα δηαδηθαζία αθνινπζείηαη θαη ζηε δεύηεξε θαξηέια (Cam2). 

΢ηελ ηξίηε θαξηέια (Properties) ππάξρνπλ νη επηινγέο Enable Liftoff θαη 

Enable Friction. Η πξώηε επηηξέπεη ζην πξώην cam λα απνκαθξπλεηαη από ην 

δεύηεξν cam θαηά ηε δηάξθεηα ρξήζεο ηνπ εξγαιείνπ Drag Components ή 

θαηά ηε δηάξθεηα αλάιπζεο κεραληζκνύ. Η δεύηεξε ελεξγνπνηεί δπλάκεηο 

ηξηβήο αλάκεζα ζηα δύν cams. 

 

 3D Contacts: Αλνίγεη ην 3D Contacts dashboard. Δδώ νξίδεηαη ε ζύλδεζε 

αλάκεζα ζε δύν κέξε πνπ βξίζθνληαη ζε δηαθνξεηηθά ζώκαηα θαη ε ζύλδεζε 

είλαη αλάκεζα ζε επηθάλεηα ή γσλία ηνπ πξώηνπ ζώκαηνο θαη ζε κηα ή 

πεξηζζόηεξεο ζθαηξηθέο, θπιηλδξηθέο ή επίπεδεο επηθάλεηεο ή γσλίεο ηνπ 

δεύηεξνπ. 

΢ην 3D Contacts dashboard ζπκπιεξώλνληαη νη ιεπηνκέξεηεο ηεο ζύλδεζεο. 

Δπηιέγνληαη δύν επηθάλεηεο αλαθνξάο από δύν parts. Όηαλ επηιεγεί γσλία ζα 

πξέπεη λα νξηζηεί ην Vertex Radius.  

΢ηελ θαξηέια Contact ξπζκίδνληαη νη ηδηόηεηεο ηεο ζύλδεζεο. Δδώ ππάξρνπλ 

δύν επηινγέο: 

o Use values: Γίλεηαη απνδνρή ησλ πξνεπηιεγκέλσλ ξπζκίζεσλ ή 

αιιαγή ησλ Poisson’s ratio, Young’s modulus, ή Damping. 

o Select material: Με πάηεκα ζην πεδίν “more” αλνίγεη ην παξάζπξν 

δηαιόγνπ “Materials” από ην νπνίν επηιέγεηαη ην επηζπκεηό πιηθό. Οη 
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ηηκέο γηα Poisson’s ratio, Young’s modulus, or Damping αλαλεώλνληαη 

απηόκαηα κε ηελ αιιαγή πιηθνύ.  

Η ηειεπηαία επηινγε “No Friction / With Friction” ελεξγνπνηεί ηηο δπλάκεηο 

ηξηβήο. 

 

 Gears: Αλνίγεη ην παξάζπξν δηαιόγνπ Gear Pair Definition γηα 

ζπκπιήξσζε ησλ ηδηνηήησλ ζύλδεζεο κεηαμύ δύν νδνλησηώλ ηξνρώλ. 

Αξρηθά ζα πξέπεη νη ηξνρνί λα είλαη πξνζαλαηνιηζκέλνη ζην assembly έηζη 

ώζηε λα κελ ππάξρεη ζύγθξνπζε. Ο πξνζαλαηνιηζκόο γίλεηαη κε ην Drag 

Components Tool.  

΢ην παξάζπξν δηαιόγνπ, ζην πεδίν Type επηιέγεηαη αξρηθά ν ηύπνο ηξνρώλ 

πνπ ρξεζηκνπνηείηαη.  

΢ηελ πξώηε θαξηέια (Gear1) ζπκπιεξώλνληαη ηα ζηνηρεία ηνπ πξώηνπ 

ηξνρνύ. Δπηιέγεηαη ν άμνλαο πεξηζηξνθήο ηνπ θαη ζπκπιεξώλεηαη ε 

δηάκεηξνο ηνπ θύθινπ θύιηζεο ζην πεδίν Pitch Circle Diameter. 

Η ίδηα δηαδηθαζία αθνινπζείηαη ζηε δεύηεξε θαξηέια (Gear2) γηα ην δεύηεξν 

ηξνρό. 

΢ηελ ηξίηε θαξηέια ζπκπιεξώλεηαη ν ιόγνο πξώηνπ/δεύηεξνπ ηξνρνύ. Αλ 

έρνπλ ζπκπιεξσζεί νη δηάκεηξνη ζηηο δύν πξώηεο θαξηέιεο, ε ηξίηε θαξηέια 

δε ρξεηάδεηαη αιιαγή. 

 

 Belts: Αλνίγεη ην Belt dashboard γηα νξηζκό ζύλδεζεο Belt – Pulley. 

Δπηιέγνληαη νη επηθάλεηεο πνπ ζα αιιειεπηδξνύλ κε ηνλ ηκάληα. Οηαλ 

επηιεγνύλ ηνπιάρηζηνλ δύν ηξνραιίεο εκθαλίδεηαη κηα πξάζηλε θακπύιε πνπ 

ππνδεηθλύεη ηελ ηξνρηά ηνπ ηκάληα.  
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Παηώληαο  ελεξγνπνηείηαη ην πεδίν ζην νπνίν κπνξεί λα ζπκπιεξσζεί ην 

κήθνο ηνπ ηκάληα. ΢ην πεδίν  εηζάγεηαη ν ζπληειεζηήο Young 

πνιιαπιαζηαζκέλνο κε ηελ επηθάλεηα ηνπ ηνκέα ηνπ ηκάληα. 

 

 Servo Motors: Αλνίγεη ην παξάζπξν δηαιόγνπ Servo Motor Definition. 

΢ηελ πξώηε θαξηέια επηιέγεηαη ν ηύπνο ηεο νληόηεηαο (Motion axis ή 

Geometry) γηα ηελ επηινγή ηεο ζέζεο ηνπ θηλεηήξα. Δπηιέγνληαη ηα ζηνηρεία 

(άμνλαο, επίπεδα θιπ) πνπ νξίδνπλ ηε ζέζε ηνπ θηλεηήξα. 

΢ηε δεύηεξε θαξηέια (profile) ζπκπιεξώλνληαη ηα ππόινηπα ζηνηρεία ηνπ 

θηλεηήξα.  

΢ην Specification νξίδεηαη ν ηύπνο θίλεζεο πνπ δίλεη ν θηλεηήξαο. Αλάινγα κε 

ηελ επηινγή εδώ (position, velocity, acceleration),  αλνίγεη ην αληίζηνηρν κελνύ 

γηα ζπκπιήξσζε ησλ απαξαίηεησλ ηηκώλ.  

 

 Mechanism Analysis: Αλνίγεη ην παξάζπξν δηαιόγνπ Analysis Definition. 

Με απηό ην εξγαιείν δεκηνπξγείηαη αλάιπζε ηνπ κεραληζκνύ. Αξρηθά 

επηιέγεηαη ν ηύπνο αλάιπζεο. Αλάινγα κε ηνλ ηύπν αλάιπζεο πνπ επηιέγεηαη, 

κεηαβάιινληαη θαη ηα πεδία πνπ πξέπεη λα ζπκπιεξσζνύλ.  

΢ηε δεύηεξε θαξηέια (Motors) θαίλνληαη νη θηλεηήξεο πνπ ππάξρνπλ ζην 

κεραληζκό.  

Η ηξίηε θαξηέια δελ είλαη ελεξγή θαηά ηελ θηλεκαηηθή αλάιπζε. Παηώληαο run 

γίλεηαη πξνζνκνίσζε ηεο θίλεζεο ηνπ κεραληζκνύ.  

Γηα έλα κεραληζκό κπνξνύλ λα γίλνπλ πνιιαπιέο αλαιύζεηο νπνηνπδήπνηε 

ηύπνπ, ρξεζηκνπνηώληαο δηαθνξεηηθνύο θηλεηήξεο θαη δπλάκεηο θαη 

επηθεληξώλνληαο ζε δηαθνξεηηθά κέξε ηνπ κεραληζκνύ θαη αγλνώληαο άιια.  

Οη ηύπνη αλάιπζεο είλαη νη εμήο: 
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Kinematic: Ο κεραληζκόο θηλείηαη κε ηε βνήζεηα servo motors θαη ε αλάιπζε 

δε ιακβάλεη ππ όςηλ ηεο ηηο δπλάκεηο πνπ επηδξνύλ ζην ζύζηεκα. 

Dynamic: Δμεηάδεηαη ε επίδξαζε ησλ βαξπηηθώλ, εμσηεξηθώλ θαη 

αδξαλεηαθώλ δπλάκεσλ ζηε κάδα ησλ ζσκάησλ ηνπ κεραληζκνύ. 

Static: Δμεηάδνληαη νη δπλάκεηο πνπ επηδξνύλ ζε ζώκα όηαλ απηό βξίζθεηαη ζε 

ηζνξξνπία. 

Force Balance: Δμεηάδνληαη νη δπλάκεηο πνπ είλαη απαξαίηεηεο γηα ηελ 

ηζνξξνπία κεραληζκνύ ζε ζπγθεθξηκέλε θαηάζηαζε. 

Position: Δμεηάδεηαη αλ ν κεραληζκόο κπνξεί λα ζπλαξκνινγεζεί κε 

ζπγθεθξηκέλα servo motor θαη ζπλδέζεηο. 

Κινημαηική ανάλσζη 

Η θηλεκαηηθή είλαη θιάδνο ηεο κεραληθήο πνπ αζρνιείηαη κε ζέκαηα θίλεζεο 

ρσξίο λα ιακβάλνληαη ππ όςηλ δπλάκεηο θαη κάδα. Η θηλεκαηηθή αλάιπζε 

πξνζνκνηώλεη ηελ θίλεζε ηνπ κεραληζκνύ, όπσο έρεη νξηζηεί κε ηα 

ραξαθηεξηζηηθά ησλ servo motors θαη ησλ ζπλδέζεσλ (joint, cam-follower, 

slot-follower θαη δεύγε ηξνρώλ).  

Δπεηδή δε ιακβάλνληαη ππ όςηλ δπλάκεηο, δε κπνξεί λα ρξεζηκνπνηεζεί force 

motor θαη δε ρξεηάδεηαη λα νξηζηνύλ νη ηδηόηεηεο κάδαο ηνπ κεραληζκνύ. 

Γπλακηθέο νληόηεηεο ηνπ κνληέινπ, όπσο ειαηήξηα, απνζβεζηήξεο, βαξύηεηα, 

δπλάκεηο, ξνπέο θαη force motors δελ επεξεάδνπλ ηελ θηλεκαηηθή αλάιπζε. 

Με ηελ θηλεκαηηθή αλάιπζε εμάγνληαη πιεξνθνξίεο ζρεηηθά κε 

o Σε ζέζε, ηελ ηαρύηεηα θαη ηελ επηηάρπλζε ησλ γεσκεηξηθώλ ζηνηρείσλ θαη 

ησλ ζπλδέζεσλ. 

o Παξεκβνιέο κεηαμύ εμαξηεκάησλ. 

o Σξνρηέο θίλεζεο ηνπ κεραληζκνύ. 

o Σν ρώξν πνπ πεξηιακβάλεηαη από όιεο ηηο πηζαλέο θηλήζεηο ηνπ 

κεραληζκνύ. 
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3. Στεδιαζμός – Σσναρμολόγηζη μητανιζμών 

3.1. Οδονηωηοί ηροτοί 

Στεδιαζμός Οδονηωηού Τροτού 

3.1.1. Οξηζκόο παξακέηξσλ. 

΢ην κελνύ Tools>Parameters νξίδνληαη νη παξάκεηξνη: N (αξηζκόο νδόλησλ), 

P (Diametral Pitch), D (δηάκεηξνο θύθινπ θύιηζεο), Phi (γσλία επαθήο) 

(εηθόλα 01) 

 

Δηθόλα 01. Οξηζκόο παξακέηξσλ 
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Δηθόλα 02. Οξηζκόο ζρέζεσλ (relations) 

Οη βαζηθέο παξάκεηξνη θαζνξίδνπλ ηηο ππόινηπεο παξακέηξνπο πνπ 

απαηηνύληαη, γηα λα νξηζηεί ην πξνθίι ηνπ δνληηνύ ελόο γξαλαδηνύ (ή ην 

πξνθίι ηνπ θελνύ ρώξνπ αλάκεζα ζε δπν δόληηα ηνπ γξαλαδηνύ). Οη 

ππόινηπεο παξάκεηξνη νξίδνληαη κε ηε κνξθή εμηζώζεσλ ζην κελνύ 

Tools>Relations (εηθόλα 02). 

 

a: ύςνο θεθαιήο 

b: ύςνο πνδόο 

Ro: αθηίλα θύθινπ θεθαιήο  

Ri: βαζηθόο θύθινο 

Rd: δηάκεηξνο θύθινπ πόδα 

Gamma_c: γ – κεηαβιεηή πνπ αθνινπζεί ην t ζην δηάζηεκα Ri – Ro 

t: παξακεηξηθή κεηαβιεηή ηνπ pro/e 

theta0: πνιηθέο ζπληεηαγκέλεο ηεο εμειηγκέλεο θακπύιεο 

 

3.1.2. ΢ρεδηαζκόο βαζηθνύ Feature 
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Γηα ην ζρεδηαζκό ηνπ βαζηθνύ feature, ζρεδηάδεηαη θύθινο (εμσηεξηθό πξνθίι 

γξαλαδηνύ). ΢ην κελνύ Tools >Relations ζπκπιεξώλνληαη νη ζρέζεηο κεηαμύ 

ησλ δηαζηάζεσλ ηνπ sketch θαη ησλ δηαζηάζεσλ ηνπ part (εηθόλα 03). 

 

Δηθόλα 03. ΢ρεδηαζκόο βαζηθνύ feature θαη νξηζκόο ζρέζεσλ αλάκεζα ζε 

δηαζηάζεηο 

Με έμνδν από ην sketch νινθιεξώλεηαη ην extrude 

3.1.3. ΢ρεδηαζκόο εμειηγκέλεο θακπύιεο\ 

 

Θα πξέπεη λα ζρεδηαζηεί κηα θακπύιε, ε νπνία ζα ρξεζηκνπνηεζεί, γηα λα 

νξηζηεί ν ρώξνο αλάκεζα από δπν δόληηα ηνπ γξαλαδηνύ. 

 

Δηθόλα 04. 

΢ην κελνύ Insert> Model Datum 

επηιέγεηαη curve. ΢ην παξάζπξν πνπ 

εκθαλίδεηαη επηιέγεηαη From Equation 

(εηθόλα 04) 
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Δηθόλα 05. Παξάζπξν επηινγήο 

ζπζηήκαηνο ζπληεηαγκέλσλ 

΢ηε ζπλέρεηα ην πξόγξακκα δεηάεη λα 

νξηζηεί έλα ζύζηεκα ζπληεηαγκέλσλ 

(εηθόλα 05).  

Δπηιέγεηαη ην «PRT_CSYS_DEF» σο 

θπιηλδξηθό (Cylindrical) (εηθόλα 06). 

 

 

Δηθόλα 06. Παξάζπξν επηινγήο ηύπνπ 

ζπζηήκαηνο ζπληεηαγκέλσλ. 

 

 

΢’ απηό ην ζεκείν εκθαλίδεηαη έλα παξάζπξν Notepad, όπνπ ζπκπιεξώλνληαη 

όιεο νη ζπλαξηήζεηο πνπ νξίδνπλ ηελ εμειηγκέλε θακπύιε, σο εμήο: 

gamma = sqrt(RO^2-Ri^2)*t 

r = sqrt(gamma^2+Ri^2) 

theta = theta0+((gamma/Ri)*(360/(2*pi)))-atan(gamma/Ri) 

z = 0 
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Δηθόλα 07. Με preview θαίλεηαη ε θακπύιε πάλσ ζην extrude πνπ 

ζρεδηάζηεθε πξηλ. 

 

 

3.1.4. Γεκηνπξγία ηνπ θελνύ αλάκεζα ζε δπν δόληηα ηνπ γξαλαδηνύ 

Θα ρξεζηκνπνηεζεί ε θακπύιε πνπ ζρεδηάζηεθε γηα λα γίλεη ην πξώην 

extruded cut πάλσ ζην πξώην extrude πνπ ζρεδηάζηεθε. 

Γίλεηαη extrude ζην επίπεδν πνπ βξίζθεηαη θαη ε θακπύιε. Η θακπύιε 

ρξεζηκνπνηείηαη σο νδεγόο γηα ηα εμήο: 

 ΢ρεδηάδεηαη θύθινο αθηίλαο κηθξόηεξεο από ην ζεκείν ηεο θακπύιεο 

πνπ βξίζθεηαη πην θνληά ζην θέληξν ηνπ θύθινπ. Ο θύθινο απηόο ζα 

είλαη ν θύθινο πνδόο (b) 

 Με ην use edge θαηαζθεπάδεηαη θακπύιε πνπ ζπκπίπηεη κε ηελ 

εμειηγκέλε θακπύιε (εηθόλα α).  
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Δηθόλα α. Υξήζε use edge γηα δεκηνπξγία θακπύιεο ζε sketch 

 ΢ρεδηάδεηαη νξηδόληηα centerline πνπ λα πεξλάεη από ην θέληξν ηνπ 

γξαλαδηνύ. 

 ΢ρεδηάδεηαη επζεία από ην θέληξν ηνπ γξαλαδηνύ κέρξη ην πην θνληηλό 

ζεκείν ηεο εμειηγκέλεο (εηθόλα β).  

 

Δηθόλα β. Έλσζε ηεο θακπύιεο κε ην θέληξν ηνπ ηξνρνύ 

 Γίλεηαη Mirror ηεο εμειηγκέλε θαη ηεο γξακκήο πνπ θηάλεη σο ην θέληξν 

κε ηε βνήζεηα ηεο νξηδόληηαο centerline. 
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 Γίλεηαη Trim ζηα κέξε γξακκώλ θαη ηόμσλ πνπ δελ είλαη 

απαξαίηεηα(εηθόλα γ) 

 ΢ην κελνύ Tools> Relations νξίδεηαη ε αθηίλα ηνπ εζσηεξηθνύ ηόμνπ ίζε 

κε ηελ παξάκεηξν Rd 

 

 

Δηθόλα γ. Σν sketch κεηά από trim 

Όηαλ νινθιεξσζεί ην sketch, πεξηέρεη κόλν κηα δηάζηαζε (αθηίλα εζσηεξηθνύ 

ηόμνπ=0.42). Σν extrude νινθιεξώλεηαη κε Remove Material ζηελ πεξηνρή 

πνπ πεξηθιείεη ην sketch (εηθόλα 08).  
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Δηθόλα 08. Remove material γηα ηελ νινθιήξσζε ηνπ feature. 

 

 

3.1.5. Γεκηνπξγία Pattern 

Αθνύ έρεη δεκηνπξγεζεί ην θελό αλάκεζα ζε δπν δόληηα, γίλεηαη pattern 

(εηθόλα 09) κε ζεκείν αλαθνξάο ηνλ άμνλα πνπ πεξλάεη από ην θέληξν ηνπ 

γξαλαδηνύ. 

Με δεμί θιηθ ζην ηειεπηαίν extrude πνπ ζρεδηάζηεθε επηιέγεηαη Pattern. 
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Δηθόλα 09. Γεκηνπξγία pattern 

 

Δηθόλα 10. Δπηινγή άμνλα θαη ινηπώλ ζηνηρείσλ γηα ην pattern 
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Δηθόλα 11. Σν Pattern νινθιεξσκέλν 
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Assembly 

Γηα ηε ζπλαξκνιόγεζε ηνπ κεραληζκνύ ζύκπιεμεο δύν νδνλησηώλ ηξνρώλ 

είλαη απαξαίηεην λα ππάξρνπλ νη άμνλεο πεξηζηξνθήο ηνπο. ΢ηε ζπγθεθξηκέλε 

πεξίπησζε δεκηνπξγνύληαη δύν άμνλεο κε ην datum axis tool (εηθόλα 01). 

 

Δηθόλα 01. Γεκηνπξγία αμόλσλ γηα ηε ζπλαξκνιόγεζε ηνπ κεραληζκνύ. 

 

Η απόζηαζε S κεηαμύ ησλ αμόλσλ ππνινγίδεηαη από ηνλ ηύπν 

 

r1: αθηίλα θύθινπ θύιηζεο ηνπ πξώηνπ ηξνρνύ 

r2: αθηίλα θύθινπ θύιηζεο ηνπ δεύηεξνπ ηξνρνύ 
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Δηθόλα 02. Assemble 

Δπηιέγεηαη assemble, γηα λα εηζαρζεί 

ην πξώην part ζην assembly (εηθόλα 

02). 

 

 

Αξρηθά επηιέγεηαη ηύπνο constraint pin (εηθόλα 03).  

 

Δηθόλα 03. Δπηινγή ηύπνπ constraint 

 Απηόο ν ηύπνο constraint είλαη απαξαίηεηνο γηα ηελ θίλεζε ηνπ ηξνρνύ γύξσ 

από ηνλ άμνλά ηνπ. 

΢ηε ζπλέρεηα, ζην tab placement, νξίδνληαη νη ζπλδέζεηο ηνπ ηξνρνύ κε ηα 

ζηνηρεία πνπ ππάξρνπλ ζην ρώξν (πεξηνξηζκόο βαζκώλ ειεπζεξίαο) σο εμήο: 

 Axis alignment: ηαπηίδεηαη ν άμνλαο ηνπ θέληξνπ πεξηζηξνθήο ηνπ 

ηξνρνύ κε έλαλ από ηνπο άμνλεο πνπ δεκηνπξγήζεθαλ ζην πξώην 

βήκα ηνπ assembly (εηθόλα 04). 
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Δηθόλα 04. Axis alignment 

 Translation: ηαπηίδνληαη ηα επίπεδα front ηνπ assembly θαη ηνπ part 

αληίζηνηρα (εηθόλα 05).  

 

Δηθόλα 05. Translation  
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 Rotation axis: ηαπηίδνληαη ηα επίπεδα top ηνπ part θαη ηνπ assembly 

(εηθόλα 06) 

 

Δηθόλα 06. Rotation Axis 

Όηαλ νινθιεξσζεί ν νξηζκόο ησλ ζπλδέζεσλ ηνπ πξώηνπ part, ζηε κπάξα 

δηαιόγνπ θαίλεηαη ην κήλπκα STATUS: Connection Definition Complete. Η 

ζπλαξκνιόγεζε ηνπ πξώηνπ ηξνρνύ νινθιεξώλεηαη κε επηβεβαίσζε θαη 

έμνδν από ην κελνύ ηεο ζπλαξκνιόγεζεο. 

 

Η ζπλαξκνιόγεζε ηνπ δεύηεξνπ ηξνρνύ γίλεηαη κε ηνλ ίδην ηξόπν. Πξνζνρή 

πξέπεη λα δνζεί ζην ηξίην ζθέινο ηνπ νξηζκνύ ησλ ζπλδέζεσλ, γηα λα κελ 

ππάξρεη ζύγθξνπζε ησλ ηξνρώλ.  

΢ηελ εηθόλα 07 θαίλεηαη νινθιεξσκέλν ην assembly δπν ηξνρώλ 

δηαθνξεηηθνύ κεγέζνπο. 
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Δηθόλα 07. Σν assembly νινθιεξσκέλν. 
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Mechanism 

Γηα λα νξηζηνύλ ηα ζηνηρεία ηνπ κεραληζκνύ, ζα πξέπεη ην assembly λα 

κεηαθεξζεί ζην application Mechanism (εηθόλα 08). 

 

Δηθόλα 08. Μεηάβαζε ζην application mechanism 

΢αλ πξνεπηινγή, ζην δεμί θάησ κέξνο ηνπ πεξηβάιινληνο εξγαζίαο θαίλνληαη 

όια ηα ζηνηρεία ηνπ κεραληζκνύ (εηθόλα 09). ΢ην αξηζηεξό κέξνο ηνπ 

πεξηβάιινληνο εξγαζίαο θαίλνληαη ηα εξγαιεία ηνπ mechanism (εηθόλα 10). 
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Δηθόλα 09. Πίλαθαο ζηνηρείσλ 

κεραληζκνύ 

 

 

Δηθόλα 10. Δξγαιεία mechanism 

΢ην ζπγθεθξηκέλν assembly ζα 

πξέπεη λα νξηζηεί ε ζρέζε κεηαμύ ησλ 

δύν ηξνρώλ. Δπηιέγεηαη ηύπνο 

ζύλδεζεο Gears (εηθόλα 11).  

  

Δηθόλα 11. Δπηινγή ηύπνπ ζύλδεζεο 

 

 

Δκθαλίδεηαη έλα παξάζπξν δηαιόγνπ, ζην νπνίν ζπκπιεξώλνληαη όια ηα 

ζηνηρεία πνπ είλαη απαξαίηεηα γηα ηνλ νξηζκό ηνπ δεύγνπο ηξνρώλ. Αξρηθά 

νξίδεηαη ν ηύπνο κεραληζκνύ σο standard. ΢ηε ζπλέρεηα, ζηα tabs “Gear 1” 

θαη “Gear 2” ζπκπιεξώλνληαη ηα ζηνηρεία ηνπ πξώηνπ θαη ηνπ δεύηεξνπ 

ηξνρνύ αληίζηνηρα. Απαξαίηεηα ζηνηρεία είλαη ν άμνλαο πεξηζηξνθήο (Motion 

Axis) (εηθόλεο 12,13) θαη ε δηάκεηξνο θύθινπ θύιηζεο (pitch circle) (εηθόλα 14) 
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Δηθόλα 12. Δπηινγή άμνλα πεξηζηξνθήο πξώηνπ ηξνρνύ 

 

Δηθόλα 13. Δπηινγή άμνλα πεξηζηξνθήο πξώηνπ ηξνρνύ 
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Δηθόλα 14. Οξηζκόο δεύηεξνπ ηξνρνύ (άμνλαο πεξηζηξνθήο θαη δηάκεηξνο 

θύθινπ θύιηζεο) 

 

Με ην εξγαιείν Drag Components 

(εηθόλα 15) θαίλεηαη ρεηξνθίλεηα ε 

θίλεζε ηνπ ελόο ηξνρνύ ζε ζρέζε κε 

ηνλ άιιν. 

 
 

Δηθόλα 15. Δξγαιείν Drag 

Components 

 



Πξνζνκνίσζε θηλεκαηηθώλ ραξαθηεξηζηηθώλ κεραληζκνύ ζε ινγηζκηθό CAD - Γθιίβα Ρόδα 

 TEI Κξήηεο, Σκήκα Μεραλνινγίαο  ΢ειίδα 36 

3.2. Τροτός ηης Γενεύης 

Ο ηξνρόο ηεο Γελεύεο (αιιηώο ζηαπξόο ηεο Μάιηαο) είλαη έλαο κεραληζκόο ν 

νπνίνο κεηαηξέπεη ηε ζπλερόκελε θπθιηθή θίλεζε ζε δηαθνπηόκελε θπθιηθή 

θίλεζε.  

Στεδιαζμός 

Κηλεηήξηνο ηξνρόο 

΢ρεδηάδεηαη δίζθνο κε δηάκεηξν 250 θαη ύςνο 5 (εηθόλα 01). 

 

΢ηελ πάλσ πιεπξά ηνπ πξώηνπ δίζθνπ ζρεδηάδεηαη νκόθεληξνο δίζθνο κε 

δηάκεηξν 180 θαη ύςνο 10 (εηθόλα 02). 

 

Γίλεηαη cut θπιηλδξηθνύ ζρήκαηνο πνπ ηέκλεη θαη ηνπο δπν δίζθνπο (εηθόλα 03). 
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΢ε απόζηαζε 175 από ην θέληξν ησλ δίζθσλ ζρεδηάδεηαη θύθινο κε δηάκεηξν 

300 θαη γίλεηαη cut (εηθόλα 04) 

 

΢ρεδηάδεηαη θύιηλδξνο κε δηάκεηξν 10 θαη ύςνο 15 (εηθόλα 05). 

 

Ο θηλεηήξηνο ηξνρόο νινθιεξσκέλνο (εηθόλα 06). 
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Κηλνύκελνο Σξνρόο 

΢ρεδηάδεηαη δίζθνο κε δηάκεηξν 300 θαη ύςνο 10 (εηθόλα 01). 

 

΢ρεδηάδεηαη νκόθεληξνο δίζθνο κε δηάκεηξν 50 θαη ύςνο 5 (εηθόλα 02). 

 

Γίλεηαη cut θπιηλδξηθνύ ζρήκαηνο πνπ ηέκλεη θαη ηνπο δπν δίζθνπο (εηθόλα 03). 
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Γίλεηαη cut γηα ην πξώην απιάθη (εηθόλα 04). Η δηάζηαζε 100 είλαη ηόμν. 

 

Γίλεηαη επαλάιεςε ηνπ πξώηνπ απιαθηνύ ζε γσλία 72˚ από ην πξώην (εηθόλα 

05). 



Πξνζνκνίσζε θηλεκαηηθώλ ραξαθηεξηζηηθώλ κεραληζκνύ ζε ινγηζκηθό CAD - Γθιίβα Ρόδα 

 TEI Κξήηεο, Σκήκα Μεραλνινγίαο  ΢ειίδα 40 

 

΢ε απόζηαζε 200 από ην θέληξν ηνπ πξώηνπ δίζθνπ θαη πάλσ ζηε δηάκεζν 

αλάκεζα από ηα δπν απιάθηα ζρεδηάδεηαη θύθινο κε δηάκεηξν 180 θαη γίλεηαη 

cut (εηθόλα 06). 

 

Γίλεηαη pattern ηνπ δεύηεξνπ απιαθηνύ σο πξνο άμνλα θαη αλά 72˚ κε 4 

επαλαιήςεηο (εηθόλα 07) 
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Γίλεηαη pattern ηνπ θπθιηθνύ cut σο πξνο άμνλα θαη αλά 72˚ κε 4 επαλαιήςεηο 

(εηθόλα 08) 

 

 

Ο θηλνύκελνο ηξνρόο νινθιεξσκέλνο (εηθόλα 09) 
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Βάζε 

Γηα πην εύθνιε ζπλαξκνιόγεζε ζρεδηάδεηαη ε βάζε ηνπ κεραληζκνύ σο εμήο 
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Assembly 

Δπηιέγεηαη assembly γηα ηελ εηζαγσγή ηνπ πξώηνπ part. Δηζάγεηαη ε βάζε κε 

default assembly (εηθόλα 01). 

 

Δηθόλα 01: ΢πλαξκνιόγεζε βάζεο 

Δπηιέγεηαη assembly γηα ηε ζπλαξκνιόγεζε ηνπ δεύηεξνπ part. Δηζάγεηαη ν 

θηλεηήξηνο ηξνρόο. Δπηιέγεηαη ηύπνο constraint pin. Απηόο ν ηύπνο constraint 

είλαη απαξαίηεηνο γηα ηελ θίλεζε ηνπ ηξνρνύ γύξσ από ηνλ άμνλά ηνπ. 

΢ηε ζπλέρεηα, ζην tab placement, νξίδνληαη νη ζπλδέζεηο ηνπ ηξνρνύ κε ηα 

ζηνηρεία πνπ ππάξρνπλ ζην ρώξν (πεξηνξηζκόο βαζκώλ ειεπζεξίαο) σο εμήο: 

Axis alignment: ηαπηίδεηαη ν άμνλαο ηνπ θέληξνπ πεξηζηξνθήο ηνπ ηξνρνύ κε 

έλαλ από ηνπο άμνλεο ηεο βάζεο (εηθόλα 02) 
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Δηθόλα 02: Πξώην ζθέινο ζπλαξκνιόγεζεο θηλεηήξηνπ ηξνρνύ (Axis 

alignment) 

Translation: ηαπηίδνληαη ε πάλσ πιεπξά ηεο βάζεο κε ηελ θάησ πιεπξά ηνπ 

part ώζηε ν θηλεηήξηνο ηξνρόο λα εθάπηεηαη ζηε βάζε (εηθόλα 03).  

 

Δηθόλα 03: Γεύηεξν ζθέινο ζπλαξκνιόγεζεο θηλεηήξηνπ ηξνρνύ (Translation) 

Δπηιέγεηαη assembly γηα ηε ζπλαξκνιόγεζε ηνπ ηειεπηαίνπ part. Δηζάγεηαη ν 

θηλνύκελνο ηξνρόο. ΢πλαξκνινγείηαη όκνηα κε ηνλ θηλεηήξην ηξνρό. Πξνζνρή 

πξέπεη λα δνζεί  ζηελ ηνπνζέηεζε απηνύ ηνπ ηκήκαηνο ώζηε λα κελ ππάξρεη 

ζύγθξνπζε κε ηνλ θηλεηήξην ηξνρό (εηθόλα 04). 
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Δηθόλα 04: ΢πλαξκνιόγεζε θηλνύκελνπ ηξνρνύ 
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Mechanism 

Σν assembly κεηαθέξεηαη ζην application mechanism γηα λα νινθιεξσζεί ν 

κεραληζκόο.  

΢ην ζπγθεθξηκέλν assembly πξέπεη λα 

νξηζηεί ε ζρέζε κεηαμύ ησλ ηξνρώλ. 

Δπηιέγεηαη ηύπνο ζύλδεζεο Cams 

(Cam - Follower) (εηθόλα 01). 

 
 

΢ην πξώην tab ηνπ παξαζύξνπ πνπ εκθαλίδεηαη ζπκπιεξώλνληαη ηα ζηνηρεία 

ηνπ πξώηνπ cam. Αξρηθά, κε ην Autoselect ελεξγνπνηεκέλν, επηιέγεηαη ε 

επηθάλεηα ηνπ πξώηνπ cam (εηθόλα 02). Σν depth Display Settings παξακέλεη 

Automatic. 

 

Δηθόλα 02: Δπηινγή πξώηνπ cam 

΢ην δεύηεξν tab ζπκπιεξώλνληαη ηα ζηνηρεία ηνπ δεύηεξνπ cam. Με ην 

Autoselect ελεξγνπνηεκέλν, επηιέγνληαη νη ηξεηο επηθάλεηεο πνπ ζρεκαηίδνπλ 

έλα απιάθη ηνπ θηλνύκελνπ ηξνρνύ όπσο θαίλεηαη ζηελ εηθόλα 03. ΢ην ηξίην 

tab επηιέγεηαη “Enable Liftoff” κε 0≤e≤1 
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Δηθόλα 03: Δπηινγή δεύηεξνπ cam 

Η ίδηα δηαδηθαζία αθνινπζείηαη θαη γηα ηα ππόινηπα απιάθηα ηνπ θηλνύκελνπ 

ηξνρνύ (εηθόλα 04). 

 

Δηθόλα 04: Οινθιεξσκέλνο κεραληζκόο 
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3.3. Sliding connector 

Στεδιαζμός  

Βάζε 

΢ρεδηάδεηαη δίζθνο κε δηάκεηξν 20mm θαη ύςνο 2mm (εηθόλα 

01)

 

Γίλεηαη cut ζε ζρήκα ζηαπξνύ (εηθόλα 02) κε βάζνο 1mm. 
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Η βάζε νινθιεξσκέλε. 

 

Slider 

Σν ηκήκα πνπ εθάπηεηαη θαη θπιάεη ζηα απιάθηα ηεο βάζεο ζρεδηάδεηαη σο 

εμήο 

 

Connector 

Η κπάξα πνπ ελώλεη ηα δύν sliders ζρεδηάδεηαη σο εμήο 
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Assembly 

Σν πξώην part πνπ ζπλαξκνινγείηαη είλαη ε βάζε. Δπηιέγεηαη assembly θαη 

εηζάγεηαη ην ζπγθεθξηκέλν Part. Απηό ην ηκήκα ηνπ κεραληζκνύ δε ζα θηλείηαη 

ζην ρώξν. Δπηιέγεηαη default ηύπνο ζπλαξκνιόγεζεο (εηθόλα 01). 

 

Δηθόλα 01. ΢πλαξκνιόγεζε βάζεο. 

Σν δεύηεξν part πνπ ζπλαξκνινγείηαη είλαη έλα slider. Δπηιέγεηαη Slider 

Constraint Set (εηθόλα 02) 

 

Δηθόλα 02. ΢πλαξκνιόγεζε slider. 



Πξνζνκνίσζε θηλεκαηηθώλ ραξαθηεξηζηηθώλ κεραληζκνύ ζε ινγηζκηθό CAD - Γθιίβα Ρόδα 

 TEI Κξήηεο, Σκήκα Μεραλνινγίαο  ΢ειίδα 52 

Axis alignment: Δπηιέγεηαη κηα αθκή ηνπ slider θαη κηα αθκή ηεο βάζεο όπσο 

θαίλεηαη ζηελ εηθόλα 03. 

 

Δηθόλα 03. Axis Alignment. 

Rotation: Δπηιέγεηαη κηα πιεπξά ηνπ slider θαη κηα πιεπξά ηεο βάζεο όπσο 

θαίλεηαη ζηελ εηθόλα 04. 

 

Δηθόλα 04. Rotation. 

Οκνίσο ζπλαξκνινγείηαη έλα δεύηεξν slider ζην άιιν απιάθη ηεο βάζεο 

(εηθόλα 05). 
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Δηθόλα 05. Γπν sliders ζπλαξκνινγεκέλα. 

΢ηε ζπλέρεηα εηζάγεηαη ζην assembly ε κπάξα πνπ ελώλεη ηα δύν sliders. 

Δδώ ζα ρξεηαζηνύλ δύν pin constraint sets, έλα γηα θάζε slider. 

Δπηιέγεηαη pin constraint set 

Axis alignment: Δπηιέγεηαη ν άμνλαο ελόο slider θαη ν άμνλαο ηεο ηξύπαο πνπ 

βξίζθεηαη ζηε κπάξα (εηθόλα 06). 

 

Δηθόλα 06. Axis alignment. 

Translation: Δπηιέγεηαη ε πάλσ πιεπξά ηνπ παξαιιειεπίπεδνπ κέξνπο ηνπ 

slider θαη ε θάησ πιεπξά ηεο κπάξαο (εηθόλα 07). 
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Δηθόλα 07. Translation. 

Δλώ ην status δείρλεη “Connection Definition Complete”, δεκηνπξγείηαη άιιν 

έλα set constraints (εηθόλα 08) θαη ηαπηίδεηαη ε ηξύπα πνπ βξίζθεηαη ζηε κέζε 

ηεο κπάξαο κε ην pin ηνπ άιινπ slider (εηθόλα 09). 

 

Δηθόλα 08. Γεκηνπξγία δεύηεξνπ constraint set. 



Πξνζνκνίσζε θηλεκαηηθώλ ραξαθηεξηζηηθώλ κεραληζκνύ ζε ινγηζκηθό CAD - Γθιίβα Ρόδα 

 TEI Κξήηεο, Σκήκα Μεραλνινγίαο  ΢ειίδα 55 

 

Δηθόλα 09. Οξηζκόο δεύηεξνπ constraint set. 

Με ην drag components tool θαη “πηάλνληαο θαη πεξηζηξέθνληαο” ην ειεύζεξν 

άθξν ηεο κπάξαο, θαίλεηαη ε ιεηηνπξγία ηνπ κεραληζκνύ.  

 

Δηθόλα 10. Οινθιεξσκέλνο κεραληζκόο 

΢ηελ εηθόλα 11 θαίλεηαη ε ηξνρηά πνπ αθνινπζεί ην ειεύζεξν άθξν ηεο 

κπάξαο (κπιε έιιεηςε). 
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Δηθόλα 11. Η ηξνρηά ηνπ ειεύζεξνπ άθξνπ ηεο κπάξαο/connector 
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3.4. Αλσζίδα 

Η αιπζίδα απνηειείηαη από πέληε δηαθνξεηηθά είδε θνκκαηηώλ.  

 

Σα rollers(3) πεξηζηξέθνληαη ειεύζεξα πάλσ ζηα bushings (2) θαη έξρνληαη ζε 

επαθή κε ην sprocket. Σα bushings είλαη θνιιεκέλα ζηα εζσηεξηθά θαιύκκαηα 

(4). Μέζα από ηα bushings πεξλάλε pins(1), ηα νπνία είλαη θνιιεκέλα ζηα 

εμσηεξηθά θαιύκκαηα (5).  
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Στεδιαζμός  

Sprocket - ηξνρόο κεηάδνζεο θίλεζεο 

Απαξαίηεηε γηα ην ζρεδηαζκό ελόο sprocket είλαη ε γλώζε ησλ δηαζηάζεσλ 

ηεο αιπζίδαο κε ηελ νπνία ζπλεξγάδεηαη. Πην ζπγθεθξηκέλα, ζα πξέπεη λα 

είλαη γλσζηά ηα Chain Pitch (P), roller diameter (d1) θαη roller width (w1). 

Δπίζεο, ζα πξέπεη λα είλαη γλσζηόο ν αξηζκόο δνληηώλ (Ν) ηνπ ηξνρνύ. Σν 

πιήζνο δνληηώλ εμαξηάηαη απνθιεηζηηθά από ηελ εθαξκνγή γηα ηελ νπνία 

πξννξίδεηαη ην assembly. ΢ηελ ζπγθεθξηκέλε πεξίπησζε Ν=15,  

Η γσλία (ζ) πνπ ζρεκαηίδεηαη αλάκεζα ζε δπν δόληηα ππνινγίδεηαη δηαηξώληαο 

360˚/Ν, άξα ζ= 24˚. 

Η δηάκεηξνο ηνπ ηξνρνύ ζα πξνθύςεη από ηα δεδνκέλα. 

Γεκηνπξγείηαη άμνλαο κε ην datum axis tool, κε references ηα Front θαη Right 

επίπεδα. 

΢ε sketch, ζην επίπεδν top, ζρεδηάδνληαη ηξεηο γξακκέο πνπ μεθηλνύλ από ην 

θέληξν ηνπ sprocket θαη απέρνπλ θαηά ζ (εηθόλα 01). 

 

Δηθόλα 01. ΢ρεδηαζκόο βνεζεηηθώλ γξακκώλ ζην sketch 
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΢ρεδηάδνληαη γξακκέο 

παξάιιειεο ζηηο 

πξνεγνύκελεο θαη ζε 

απόζηαζε ίζε κε chain 

pitch (P=6.25) (εηθόλα 02). 

 

 

Δηθόλα 02. ΢ρεδηαζκόο παξάιιεισλ γξακκώλ. 

 

΢ηηο ηνκέο ησλ παξάιιεισλ 

γξακκώλ ζα βξίζθνληαη rollers 

(εηθόλα 03). 

 

Δηθόλα 03. Η ηνκή ησλ γξακκώλ δείρλεη 

πνύ ζα βξίζθνληαη νη άμνλεο 

πεξηζηξνθήο ησλ rollers. 

΢ρεδηάδνληαη θύθινη κε δηάκεηξν ίζε κε roller diameter (d1=6) θαη γξακκή πνπ 

ελώλεη ηα θέληξα ησλ θύθισλ (εηθόλα 04)  
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Δηθόλα 04. ΢ρεδηαζκόο θύθισλ θαη νξηδόληηαο γξακκήο πνπ ελώλεη ηα θέληξα 

ηνπο. 

Από ηα θέληξα ησλ πξώησλ θύθισλ ζρεδηάδνληαη κεγαιύηεξνη  θύθινη, ν 

θαζέλαο από ηνπο νπνίνπο λα εθάπηεηαη κε ηνλ απέλαληη  κηθξό θύθιν (ε???) 

(εηθόλα 05) 

 

Δηθόλα 06. ΢ρεδηαζκόο κεγαιύηεξσλ θύθισλ. 
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Γίλεηαη trim ώζηε λα κείλεη ζην 

sketch κόλν ην πξνθίι ηνπ 

δνληηνύ (εηθόλα 06). 

 

 

Δηθόλα 06. Πξνθίι ελόο δνληηνύ ηνπ sprocket. 

Σν sketch ζπκπιεξώλεηαη κε γξακκέο πνπ νινθιεξώλνπλ ην πξνθίι ηνπ 

πξώηνπ extrude (εηθόλα 07).  

 

Δηθόλα 07. Οινθιεξσκέλν sketch. 

Γίλεηαη extrude κε πάρνο ίζν κε  

S = 0.93 × Roller Width – 0,1524mm  ≈ 4.508 

΢ην extrude πνπ δεκηνπξγείηαη από ην sketch γίλεηαη pattern γύξσ από ηνλ 

άμνλα πνπ δεκηνπξγήζεθε ζηελ αξρή ηνπ part (εηθόλα 08).  
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Δηθόλα 08. Γεκηνπξγία pattern σο πξνο άμνλα. 

΢ην pattern πεξηέρνληαη 

15 pattern members 

αλά 24˚ (εηθόλα 09). 

 

 

Δηθόλα 09. Pattern 
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Δηθόλα 10.Σν sprocket νινθιεξσκέλν  

 

΢ρεδηάδνληαη έλα έλα ηα επηκέξνπο parts ηνπ assembly ηεο αιπζίδαο. 

Roller 

 

 

Pin 
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Bushing 

 

 

Inner plate 
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Outer plate 

 

 

 

 

 

 

 

 

 



Πξνζνκνίσζε θηλεκαηηθώλ ραξαθηεξηζηηθώλ κεραληζκνύ ζε ινγηζκηθό CAD - Γθιίβα Ρόδα 

 TEI Κξήηεο, Σκήκα Μεραλνινγίαο  ΢ειίδα 66 

Σξνρηά 

΢ρεδηάδεηαη ε ηξνρηά ηελ νπνία ζα αθνινπζεί ε αιπζίδα ζην ηειηθό assembly 

(εηθόλα 09).  

 

Δηθόλα 09. ΢ρεδηαζκόο ηξνρηάο θίλεζεο αιπζίδαο. 

Οη δηαζηάζεηο ηεο ηξνρηάο είλαη απνηέιεζκα ησλ δηαζηάζεσλ ηνπ θηλεηήξηνπ 

ηξνρνύ (sprocket). 
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Assembly 

Σα ζρεδηαζκέλα parts ζπλδπάδνληαη γηα λα δεκηνπξγεζνύλ δύν assemblies. 

Roller Assembly 

΢πλαξκνινγείηαη έλα inner plate κε default ηύπν ζπλαξκνιόγεζεο (εηθόλα 01). 

 

Δηθόλα 01. ΢πλαξκνιόγεζε Inner plate. 

΢ηε ζπλέρεηα ζπλαξκνινγνύληαη δύν rollers εθαπηόκελα ζην inner plate 

(εηθόλα 02). 

 

Δηθόλα 02. ΢πλαξκνιόγεζε rollers. 

Σέινο, ζπλαξκνινγείηαη έλα inner plate εθαπηόκελν ζηελ πάλσ πιεπξά ησλ 

rollers (εηθόλα 03) θαη ην roller assembly είλαη έηνηκν. 
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Δηθόλα 03. ΢πλαξκνιόγεζε inner plate θαη νινθιήξσζε ηνπ assembly. 

Γηα ιόγνπο απινπνίεζεο ηνπ ηειηθνύ assembly έρνπλ παξαιεηθζεί ηα 

bushings. Μπνξνύλ, νπνηαδήπνηε ζηηγκή, λα πξνζηεζνύλ ζην roller 

assembly. 

Γεκηνπξγνύληαη έλα datum plane πνπ δηρνηνκεί ην assembly θαη δύν datum 

points πνπ βξίζθνληαη πάλσ ζ’ απηό ην επίπεδν θαη ζηελ ηνκή ηνπ κε ηνπο 

άμνλεο ησλ rollers (εηθόλα 04). Σα ζηνηρεία απηά ζα ρξεζηκεύζνπλ θαηά ηελ 

ηειηθή ζπλαξκνιόγεζε ηνπ κεραληζκνύ. 

 

Δηθόλα 04. Δπίπεδν θαη ζεκεία. 

Pin Assembly 

΢πλαξκνινγείηαη έλα outer plate κε default ηύπν ζπλαξκνιόγεζεο (εηθόλα 

05). 
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Δηθόλα 05. ΢πλαξκνιόγεζε outer plate. 

΢ηε ζπλέρεηα ζπλαξκνινγνύληαη δπν pins (εηθόλα 06). 

 

Δηθόλα 06. ΢πλαξκνιόγεζε pins. 

 

 

 

Σέινο ζπλαξκνινγείηαη έλα outer plate (εηθόλα 07) θαη ην pin assembly είλαη 

έηνηκν. 
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Δηθόλα 07. ΢πλαξκνιόγεζε outer plate θαη νινθιήξσζε assembly. 

Γεκηνπξγνύληαη έλα datum plane πνπ δηρνηνκεί ην assembly θαη δύν datum 

points πνπ βξίζθνληαη πάλσ ζ’ απηό ην επίπεδν θαη ζηελ ηνκή ηνπ κε ηνπο 

άμνλεο ησλ pins (εηθόλα 08). Σα ζηνηρεία απηά ζα ρξεζηκεύζνπλ θαηά ηελ 

ηειηθή ζπλαξκνιόγεζε ηνπ κεραληζκνύ. 

 

Δηθόλα 08. Δπίπεδν θαη ζεκεία. 

Σειηθό assembly 

΢’ απηό ην ζεκείν, όια ηα parts πνπ ζπλζέηνπλ ην κεραληζκό αιπζίδα-

θηλεηήξηνο ηξνρόο, είλαη  έηνηκα.  
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Γεκηνπξγείηαη λέν assembly file γηα ηελ ηειηθή ζπλαξκνιόγεζε ησλ ζηνηρείσλ. 

Σν πξώην part πνπ ζπλαξκνινγείηαη είλαη ε ηξνρηά. Δπηιέρζεθε απηό ην part 

γηα ράξηλ επθνιίαο ζπλαξκνιόγεζεο ησλ ππνινίπσλ parts θαη γηαηί είλαη ην 

κόλν κε θηλεηό κέξνο ηνπ κεραληζκνύ. Δπηιέγεηαη default ηύπνο 

ζπλαξκνιόγεζεο γη απηό ην part (εηθόλα 10). 

 

Δηθόλα 10. ΢πλαξκνιόγεζε ηξνρηάο θίλεζεο αιπζίδαο. 

΢ηε ζπλέρεηα ζπλαξκνινγείηαη ν θηλεηήξηνο ηξνρόο. Δπηιέγεηαη ηύπνο 

constraint pin.  

Axis alignment: ηαπηίδεηαη ν άμνλαο πεξηζηξνθήο ηνπ ηξνρνύ κε έλαλ άμνλα 

πνπ έρεη ζρεδηαζηεί πάλσ ζηελ ηξνρηά (εηθόλα 11). 

 

Δηθόλα 11. Axis alignment. 
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Translation: ηαπηίδεηαη έλα επίπεδν πνπ δηρνηνκεί ην sprocket κε ην επίπεδν 

πάλσ ζην νπνίν έρεη ζρεδηαζηεί ε ηξνρηά (εηθόλα 12).  

 

Δηθόλα 12. Translation 

Με απηέο ηηο ξπζκίζεηο ζα πξέπεη ν θηλεηήξηνο ηξνρόο λα κπνξεί λα 

πεξηζηξέθεηαη ειεύζεξα γύξσ από ηνλ άμνλά ηνπ, ρσξίο λα μεθεύγεη από ην 

επίπεδν πνπ βξίζθεηαη ε ηξνρηά πάλσ ζηελ νπνία ζα θηλείηαη ε αιπζίδα. 

΢ηε ζπλέρεηα ζπλαξκνινγείηαη έλα roller assembly. Ο ζθνπόο εδώ είλαη λα 

θηλείηαη ν ζπγθεθξηκέλν part πάλσ ζηελ πξνθαζνξηζκέλε ηξνρηά, ρσξίο λα 

πεξηζηξέθεηαη γύξσ από ηνλ εαπηό ηνπ. Θα ρξεηαζηνύλ ηξία constraint sets. 

Αξρηθά επηιέγεηαη ηύπνο constraint slot (εηθόλα 13) 
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Δηθόλα 13. Δπηινγή πξώηνπ ζεη ζηνηρείσλ ζπλαξκνιόγεζεο - Slot constraint 

set 

΢αλ πξώην Point on line επηιέγεηαη ην 

έλα ζεκείν πνπ είρε δεκηνπξγεζεί 

πάλσ ζην roller assembly (εηθόλα 14). 

 

 

Δηθόλα 14. Δπηινγή ζεκείνπ. 

 

΢αλ δεύηεξν ζηνηρείν επηιέγεηαη ε ηξνρηά (εηθόλα 15). 
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Δηθόλα 15. Δπηινγή ηξνρηάο. 

΢ην tab Placement επηιέγεηαη New Set γηα λα νξηζηεί ην δεύηεξν constraint 

set. Δπηιέγεηαη Planar constraint set (εηθόλα 16) θαη ηαπηίδεηαη ην επίπεδν πνπ 

δηρνηνκεί ην roller assembly κε ην επίπεδν πάλσ ζην νπνίν βξίζθεηαη ε ηξνρηά 

(εηθόλα 17). 

 

Δηθόλα 16. Δπηινγή Planar constraint set. 
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Δηθόλα 17. Δπηινγή επηπέδσλ γηα νξηζκό ηνπ planar constraint set. 

΢ην tab Placement επηιέγεηαη New Set γηα λα νξηζηεί ην ηειεπηαίν constraint 

set. Δπηιέγεηαη Slot constraint set. Αθνινπζείηαη ε ίδηα δηαδηθαζία κε ην πξώην 

ζθέινο ηεο ζπλαξκνιόγεζεο ηνπ roller assembly, απηή ηε θνξά γηα ην 

δεύηεξν datum point ηνπ (εηθόλα 18).  

 

Δηθόλα 18. Δπηινγή ηξνρηάο ζην δεύηεξν slot constraint set θαη νινθιήξσζε 

ζπλαξκνιόγεζεο ηνπ roller assembly. 
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΢ηε ζπλέρεηα ζπλαξκνινγείηαη έλα pin assembly. Η δηαδηθαζία πνπ 

αθνινπζείηαη εδώ, δηαθέξεη από απηή ηνπ πξώηνπ roller assembly θαη είλαη 

απηή πνπ ζα αθνινπζεζεί γηα ηε ζπλαξκνιόγεζε ησλ ππνινίπσλ parts ηεο 

αιπζίδαο. Δπηιέγεηαη pin constraint set. 

Axis alignment: ηαπηίδεηαη ν άμνλαο 

ηνπ πξώηνπ pin κε ηνλ άμνλα ηνπ 

δεύηεξνπ roller από ην roller 

assembly (εηθόλα 19). 

 

Δηθόλα 19. Axis alignment 

 

Translation: ηαπηίδνληαη ηα 

datum planes πνπ 

δηρνηνκνύλ ην roller 

assembly θαη ην pin 

assembly (εηθόλα 20). 

 

 

 Δηθόλα 20. Translation 

  

΢ην tab placement επηιέγεηαη New Set γηα ηελ πξνζζήθε δεύηεξνπ constraint 

set. Δπηιέγεηαη Slot constraint set θαη επηιέγνληαη ην δεύηεξν datum point ηνπ 

pin assembly θαη ε ηξνρηά (εηθόλα 21). 
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Δηθόλα 21. Δπηινγή ζηνηρείσλ γηα ην Slot constraint set.  

Με ηνλ ηξόπν απηό κπνξνύλ λα ζπλαξκνινγεζνύλ ελαιιάμ roller assemblies 

θαη pin assemblies γηα λα θαιπθζεί ε ηξνρηά θαη λα θιείζεη ε αιπζίδα (εηθόλα 

22).  

 

Δηθόλα 22. Οινθιεξσκέλν assembly αιπζίδαο κε δύν ηξνρνύο. 
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Δηθόλα 23. Άιιν παξάδεηγκα assembly αιπζίδαο  
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Mechanism 

Σν assembly κεηαθέξεηαη ζην application mechanism γηα ηνλ νξηζκό ησλ 

ζηνηρείσλ ηνπ κεραληζκνύ.  

Γηα θάζε roller ηνπ assembly ζα 

πξέπεη λα νξηζηεί ζρέζε cam-follower 

κε ηνλ θηλεηήξην ηξνρό. Δπηιέγεηαη 

ηύπνο ζύλδεζεο Cams (εηθόλα 01). 

 
 

Δηθόλα 01. Δπηινγή ηύπνπ ζύλδεζεο 

 

΢ην πξώην tab ηνπ παξαζύξνπ πνπ εκθαλίδεηαη ζπκπιεξώλνληαη ηα ζηνηρεία 

ηνπ πξώηνπ cam. Αξρηθά, κε ην Autoselect ελεξγνπνηεκέλν, επηιέγεηαη ε 

εμσηεξηθή επηθάλεηα ηνπ θηλεηήξηνπ ηξνρνύ (εηθόλα 02). Σν depth Display 

Settings παξακέλεη Automatic. 

 

Δηθόλα 02. Δπηινγή επηθάλεηαο θηλεηήξηνπ ηξνρνύ, πξώην cam. 
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΢ην δεύηεξν tab ζπκπιεξώλνληαη ηα ζηνηρεία ηνπ δεύηεξνπ cam. Με ην 

Autoselect ελεξγνπνηεκέλν, επηιέγεηαη ε εμσηεξηθή επηθάλεηα ηνπ πξώηνπ 

roller (εηθόλα 03). Σν depth Display Settings παξακέλεη Automatic.  

 

Δηθόλα 03. Δπηινγή επηθάλεηαο roller, δεύηεξν cam. 

΢ην ηξίην tab επηιέγεηαη “Enable Liftoff” κε 0≤e≤1  

Με ηνλ ίδην ηξόπν νξίδεηαη ε ζρέζε όισλ ησλ rollers κε ηνλ θηλεηήξην ηξνρό. 

“Πηάλνληαο” θαη ζέξλνληαο ην roller assembly κε ην εξγαιείν drag components 

θαίλεηαη ε αιιειεπίδξαζε ηνπ roller κε ηνλ θηλεηήξην ηξνρό. ΢ε έλα assembly 

κε νινθιεξσκέλε αιπζίδα, κπνξεί λα πξνζηεζεί θηλεηήξαο ζηνλ άμνλα 

πεξηζηξνθήο ηνπ θηλεηήξηνπ ηξνρνύ (εηθόλα 04) γηα απηόκαηε θίλεζε ηνπ 

κεραληζκνύ. 
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Δηθόλα 04. Πξνζζήθε servo motor γηα θίλεζε ηνπ θηλεηήξηνπ ηξνρνύ. 
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4. Σσμπεράζμαηα 

΢ηελ εξγαζία απηή δηεξεπλήζεθαλ νη δπλαηόηεηεο ηνπ Pro/Engineer όζνλ 

αθνξά ζην ζρεδηαζκό, ηε ζπλαξκνιόγεζε θαη ηνλ νξηζκό ησλ ζηνηρείσλ 

κεραληζκώλ κε ζθνπό ηελ πξνζνκνίσζε ησλ θηλεκαηηθώλ ραξαθηεξηζηηθώλ 

ηνπο.  

Από ηα ζρέδηα πνπ δεκηνπξγήζεθαλ γηα ηελ εξγαζία πξνθύπηεη όηη ην 

Pro/Engineer ιόγσ ηνπ παξακεηξηθνύ ζπζηήκαηνο πνπ ρξεζηκνπνηεί, είλαη 

πνιύ απνηειεζκαηηθό ινγηζκηθό κνληεινπνίεζεο κεραληζκώλ. Ο ζπζρεηηζκόο 

αλάκεζα ζηα features αιιά θαη ηα parts θαη ε δπλακηθή θαη θηλεκαηηθή 

αλάιπζε πνπ πξνζθέξεη, πξνζζέηεη επειημία ζην ζρέδην θαη δπλαηόηεηεο 

βειηηζηνπνίεζήο ηνπ. 

Σν πξόγξακκα παξέρεη όινπο ηνπο βαζηθνύο ηύπνπο ζπλδέζεσλ, γεγνλόο 

πνπ θάλεη πνιύ απνδνηηθή ηελ αλάιπζε θαη αμηνιόγεζε. 

Η έιιεηςε ιεπηνκεξώλ ζεσξεηηθώλ βνεζεκάησλ γηα ην mechanism έθαλε 

δύζθνιε θαη ρξνλνβόξα ηε δηαδηθαζία νξηζκνύ ησλ ζηνηρείσλ θάπνησλ 

κεραληζκώλ.  

Με ηε ρξήζε θηλεκαηηθήο αλάιπζεο ζε κεραληζκνύο, ε δηαδηθαζία ζρεδηαζκνύ 

ηνπο γίλεηαη πην γξήγνξε θαη αθξηβήο. Απμάλεηαη ε απνηειεζκαηηθόηεηα ησλ 

ηξηζδηάζηαησλ κεραλνινγηθώλ ζρεδίσλ θαη κεηώλεηαη ν ρξόλνο θαη ην θόζηνο 

παξαγσγήο θπζηθώλ κνληέισλ.  

Η ρξήζε ησλ εξγαιείσλ πξνζνκνίσζεο θίλεζεο κεραληζκώλ δίλεη ζην 

ρξήζηε κηα πην ζαθή εηθόλα ηεο ιεηηνπξγίαο ηνπ κεραληζκνύ θαη ηε 

δπλαηόηεηα λα εμεηάζεη αλ ν κεραληζκόο ηθαλνπνηεί ηηο ιεηηνπξγηθέο 

απαηηήζεηο θαη ηηο απαηηήζεηο θίλεζήο ηνπ. 
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